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Preface
JAST was programmed by Java 6 SE. The documentation was generated by DocBook. In order to use
JAST the Java Runtime Environment (JRE) must be installed on your system. There are two versions of
JAST: One have to be installed and another portable version can easily be unpacked from a ZIP archive. If
you use the portable version the changes will be saved in a subfolder of the starting folder and no entries
will be stored in the Windows registry if you run it on a Windows system.

The handbook is available in the formats PDF and HTML. You have to activate JavaScript in your web-
browser in oder to show correctly the HTML help.

If you want to use JAST it shall be at your own risk!

Beyond there are a web application which can use JAST compatible data bases. This application is called
JAWS and the acronym stands for JAST Web Server. Further information about JAWS can be seen on the
SourceForge project site (JAWS on SourceForge [http://sourceforge.net/projects/jastjaws/]).

If you are interested in improving the application JAST and its documenation don't hesitate to contact me
Markus.Flingelli@gmx.de [mailto:markus.flingelli@gmx.de].

JAST will no be developed further. I confine myself to fix reported bugs.

http://sourceforge.net/projects/jastjaws/
http://sourceforge.net/projects/jastjaws/
mailto:markus.flingelli@gmx.de
mailto:markus.flingelli@gmx.de
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Chapter 1. Manage Product Backlog
You can create a new product by selecting the item File → New in the menu bar. The view as you can
see in Figure 1.1, “Product information” will open.

Figure 1.1. Product information

The epics are sorted ascending alphabetically, the backlog items are sorted ascending according to their
priority and the tasks are sorted ascending alphabetically to their title.

Each product must have a non empty title. The value for the product owner must not be set. In the choice
box Unit you define the used metric for the cost estimation. You can choose between Hours, Days,
Weeks, Months, Function points and Story points. This metric is used for example by the
sprint burn down chart (see Section 4.2, “Sprint burndown chart”) or if you execute the costs calculation.
If you activate the automatic update of the time units the set time values will be converted to the new unit
(see Section 5.1.8, “Conversion”).

Hint

Keep in mind that the conversion can produce rounding errors.

In the text field Description you can insert a description of your project. You can only insert text. This
text field is a so-called extended input field. You can use the markup language descriped in Section A.3,
“Replacement of characters in LaTeX reports”.

Symbol Meaning

Edit input

HTML preview of the input

Table 1.1. Preview symbols

In the tree view the root node represents the product. The nodes of the first order are the so-called epics.
Epics are used to group backlog items. The nodes of the second order are the backlog items. The backlog
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items can be splitted into tasks. You can assigns tasks per drag and drop to other backlog items. And you
can per drag and drop move backlog items from one epic to another epic.

You can filter entries by inserting a text that is contained in the title of the task or in the topic of the backlog
item. The filter ignores upper and lower case. If you want to show only the tasks of the current sprint you
can choose the option Show tasks of the current sprint. If you choose the option Hide
done tasks all tasks that are done won't be displayed. If you choose the option Hide done backlog
items all completly done backlog items (including their tasks) will be faded out.

Figure 1.2. Budget management

The tasks of the current sprint are emphasized in the tree view (bold and italic). According to the state of
the task or if the task contains an attachement a black filled circle in the right top corner will be displayed.

Symbol Attachment provided State of the task

not started

in progress

to verify

pending

undone

done

Table 1.2. Task symbols

If you want to do a cost calculation you can insert the values in the tab Budget. You can insert the budget
and the currency. Furthermore you can insert cost categories and assign the categories to team members.

In the tab Statistic you can see the amount of backlog items and tasks. The remaining time and the
completion will be displayed. The remaining time of the backlog is calculated from the remaining time
of its tasks (see Figure 2.2, “Time recording”). If a backlog item isn't estimated the estimation will be
calculated automatically from the estimation from the tasks. The remaining time of the task is calculated
from the column To do in the timekeeping view. The time units of a task that isn't assigned to a member
will be summed up to the imaginary user -.

Note
If you have selected a task as done and there is a remaining effort it will be not considered for
the costs calculation.
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If you want to do a costs estimation you can insert in the tab Planning the intended working units. The
costs are listed if you have assigned cost categories to each member.

In the input field you can execute simple arithmetic expressions. The first character must be the equals sign
and then follows the arithmetic expression. You can use addition, subtraction, multiplication and division.
Modulo calucation is possible, too. Following you can see sample examples:

Example 1.1. Supported arithmetic expressions

• =5*8 is 40.

• =(10-2)/4 is 2.

• =33%10 is 3.

You can use the arithmetic expressions in the fields of the estimated working units of the the backlog items,
the tasks and in the table of timekeeping (Section 2.1, “Time recording”).

Note

Keep in mind that arithmetical expressions will not be saved (only their calculated values).

You can select this view by choosing in the menu bar View → Product backlog or clicking the

symbol  in the tool bar.

1.1. Team

1.1.1. Management

All members will be displayed in the table in the tab Team. The values of the columns Email address
and Description are stored but aren't use in JAST at the moment. You can change the name of the
team members. This change will update the assigned tasks.

Figure 1.3. Team management view

If you want to insert a new member, click the button Add new member. In the table a new empty
row will be inserted. If you want to delete a member you have to select him in the table and then click
the button Delete member. You can select more than one member in the table if you press the Ctrl
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or the Shift key while selecting the row with the mouse button. All changes and deletions will be active
immediately in the product backlog.

You can assign a color to each member. The assignment is used in the pinboard view (see Section 1.6,
“Pinboard”) and in the diagram of the member velocity (see Section 4.6, “Member velocity”).

The passwords aren't stored in clear text. The passwords are combined with a so-called salt and the hash
value of the salted password is stored. It is extremley unlikley that this value can be back counted in
reasonable time. If an user has set a password you will see the value ******** otherwise the string
<empty> will be displayed.

In the column Administrator you can determine if the user should have an adminstrator role in the
web server application (JAWS).

Important

The login name has to be unique.

1.1.2. Charter

The tab Charter shows the team charter. The charter is valid over the complete product life time.

1.2. Web user

If you use the application JAWS (JAST web server) it is possible that other persons than team members
should have access to the product backlog. In this case you add web users. If you add a web user and don't
select the option Administrator this user will one have reading access to the items in the product
backlog.

Figure 1.4. Web user

Important

A chosen login name has to be unique within the team and the web users. There can't exist a team
member named guest and a web user named guest in the same product.
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Note
This tab is only relevant if you want to use the web application JAWS.

1.3. Backlog items

You can insert new backlog items in the product backlog by clicking in the left tree view with the right
mouse button and choosing the item Add backlog item in the opening context menu. Alternatively
you can press the Ins key. The product or an epic must be selected. The view in the product backlog tree is
sorted ascendingly by the priority of the backlog items. Backlog items with no priority have automatically
the priority - and will be shown first.

Note
Keep in mind that the name of a backlog item (topic) must be unique within the product backlog.

You can use the method MuSCoW for priorization. You can choose between the levels MUST, SHOULD,
COULD and WONT. The type of priorization can be changed in the product information (see Figure 1.1,
“Product information”).

If you want an automatic calculation of the backlog items out of the established task efforts you have
to change to the product view and select the option Automatic update (see Figure 1.1, “Product
information”).

The group element Epic is a container of some backlog items. You can assign some backlog items or
user stores to an epic. This is often called story mapping.

If you create a new backlog item it contains by default the specified epic value from the options dialog (see
Section 5.1.7, “Default values”). The topic of the backlog item is created from the default value followed
by a blank and an integer. You can change the topic of the backlog item.

If you select a backlog item in the tree view you can copy it with the short cut Ctrl+C or paste it with
the short cut Ctrl+V. You can use the corresponding menu items in the context menu, too. The topic of a
backlog item must be unique. In the case of copying a backlog item it will be created from the original topic
combined with an integer in braces. If you copy a backlog item all of its tasks will be copied, too. If you
copy a backlog item to another product the values of the team members and the sprints will be reverted.

If a backlog item is selected in the tree view you can change the priority by pressing - in order to decrement
the priority by one or press + in order to increment the priority by one. The maximum priority is limited to
the value you specified in the default value tab of the options settings (see Section 5.1.7, “Default values”).

1.4. Tasks

A backlog items consists of an arbitrary number of tasks. You can insert a task by selecting the menu item
Add task in the context menu or by clicking the short cut Ins. The title of the task must be unique in the
backlog item. By default the title of the new task will be created from the default value set in the options
dialog (see Section 5.1.7, “Default values”).

You can assign tasks to team members. If there is only one team member in the product all newly created
tasks will be assigned to this team member. The status of a task can have one of the following values not
started, in progress, to verify, done, undone or impeded. If a task is marked as done
you can't change its values. In this case you must set the status to something different from done and then
you can change the tasks values. You can only assign tasks to a sprint (not backlog items). A task can
only assigned to one sprint. It is not required to assign all tasks of a backlog item to the same sprint. In the
working date table in the tab Working date the timekeeping of the task will be displayed. This table
can't be changed. The timekeeping is explained in Section 2.1, “Time recording”.
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You can attach an arbitrary count of attachments to a task. If the attachment is an image in the format PNG,
GIF or JPEG it will be displayed. If the attachment is not an image it can directly opened if the application
is registrated in the operating system.

Figure 1.5. Attachments

Important

The file size of each attached file is limited to 16 MB. If you store your product backlog in an XML
file there are no size limitations.

You can insert a new task by clicking the key Ins in the text field Title. The newly created task will be
selected and you can immediately change the title.

If you are within the view Product backlog (see Figure 1.1, “Product information”) you can change
the assignment of the tasks to a backlog item by drag and drop. It is only possible to select one task.

If you press the button  the current sprint will be assigned to the selected task. If no sprint takes place
the empty sprint will be assigned.

If you select a task in the tree view you can insert a task via the context menu or the short cut Ctrl+C and
paste a task via the context menu or the short cut Ctrl+V. If you insert the task in the same backlog item
an unique title will be created. You can only insert the task if you have selected a backlog item first.

Note

Tasks that are done are editable after you change the status to something else than done. If you
have selected a done task the tool bar in the description field is hidden.

1.5. Task overview

You can open the task overview via the menu bar View → Task overview or by clicking the icon

 in the tool bar. In this view all tasks will be listed. You can sort the table. The columns Backlog
item title, Epic, Task title, Sprint, Member and Status are changeable. The column
Completion show the completion of the tasks in percent.
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Figure 1.6. Task overview

If you mark rows in the task overview and move the cursor over the table a tool tip with the previous and
future costs will appear. This only works if you have assigned cost categories to the team members.

Figure 1.7. Task overview with its costs in the tool tip

If there are more than one rows selected and you press the right mouse button a popup will open. In this
context menu you can change the sprint, the member or the status of the selected tasks. The change will
be set to the changeable tasks. If there are tasks in the selection with the status done for this tasks only
the status can be changed not the team member and the sprint.

You can delete the selected tasks. The selection must not be cohesive. The deletion of the tasks must be
confirmed in a dialog.

If you click in the table with the right mouse button to its caption a filter dialog will open (see Figure 1.8,
“Filtering”). You can set filter values in arbitrary columns.

Figure 1.8. Filtering

1.6. Pinboard

In this view all tasks of the current sprint are displayed. You can open the view via the menu bar View
→ Pinboard or clicking the symbol  in the tool bar. If no sprint takes place at the moment you will
get a hint.

The pinboard cards contain the task title, the topic of the backlog item, the team member and the state of
completion. The pinboard has six columns: not started, in progress, to verify, impeded,
undone and done. You can change the tasks status via drag and drop.

If you double click to a task on the pinboard you will change to the product backlog item view and the
task will be selected.
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1.7. Impediments

You can show the impediments by selecting View → Impediments in the menu bar or clicking the

symbol  in the tool bar.

Figure 1.9. Impediments

You can insert new impediments by clicking the right mouse button in the left view and selecting Add
impediment or pressing the key Ins. Impediments that are done are marked with a green check mark.
Not solved impediments will be marked with a white cross on red background.

Symbol State of the impediment

open

closed

Table 1.3. Impediment symbols

The default title of the impediments can be changed in the option settings dialog in the tab Default
values. The title of newly created impediments is the default value. The title of an impediment must not
be unique in contrast to the topic of a backlog item or the title of a task. No number will be automatically
appended to the title of an impediment.

1.8. Releases

You can specify in the releases view the releases you want to deliver. You can assign releases to backlog
items and sprints.
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Figure 1.10. Release management

If you choose the tab Backlog items all backlog items including their tasks will be displayed in the
table (see Figure 1.11, “Backlog items”).

Figure 1.11. Backlog items

1.9. Import/Export OpenOffice

You can export the product backlog to an OpenOffice document and you can import a product backlog from
it. If you want to use the import method the OpenOffice document must fulfill the following requirements:
• The product backlog must be in the first table of the document.
• The backlog items or tasks are listed from row 2 on. The first row contains the optional description of

the colums
• The items must be listed continously from row 2 to row n.
• The table must have the following structure:

• Column A: Priority (optional).
• Column B: Topic of the backlog item (mandatory).
• Column C: Title of the task (optional).
• Column D: First name of the team member (optional).
• Column E: Surname of the team member (optional, if a value is set in column D this column must

be set, too).
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• Column F: Estimation of the task (optional).
• Column G: Status (optional).
• Column H: Sprint (optional).
• Column I: Begin of the sprint (optional, if the value in column H is set, this column must be set, too).
• Column J: End of the sprint (optional, if the value in column H is set, this column must be set, too).
• Column K: Description of the backlog item. The description of a backlog item occurs on its first

appearance (optional).
• Column L: Description of a task (optional).
• Column M: Acceptance of a backlog item. The acceptance must occur on the first appearance of the

backlog item (optional).
• Column N: Requirements of the backlog item. The requirements must occur on the first appearance

of the backlog item (optional).
• Column O: Name of the epic. The epic must occur on the first appearance of the backlog iem (op-

tional).
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Chapter 2. Sprint management
You can open the sprint management view via the menu View → Sprint manager or you can click the

symbol  in the tool bar. If there is a sprint in this view, the current sprint will be selected. If currently
no sprint takes places the first sprint in the list will be selected. The current sprint is emphasized (bold
and italic). You can insert new sprints by opening the context menu with the right mouse button. The
default name of the new sprint can be changed in the option settings in the tab Default values. And
in addition you can set the default sprint duration.

If you insert a sprint you must set its title, the start and the end date. The title must at least consists of one
character and it must be unique. There can't exist two sprints with the same name.

If you rename a sprint the assignment of a task to the sprint is not be concerned. The task will be automat-
ically updated. If you delete a sprint all tasks that were related to this sprint have then no sprint assignment
anymore.

The periods of the sprints can't overlap. A sprint can start if the previous sprint has ended. It is not possible
to plan a sprint, that begin at that day another sprint ends on it.

In the tab No working days the sprints will be displayed in yellow background color. The current
sprint will be displayed cyan. If the current day is a day of the sprint, a non working day, a moveable feast
or a feast it will be displayed in green.

You can insert non working days by selecting the day or the days und then select in the context menu
the item Add non working day (see Figure 2.1, “Non working days”). If you want to delete a non
working day select in the context menu the item Remove non working day. You can only delete
the non working days of the selected sprint in the left sprint list. In the calendar view of the non working
days you can also plan a sprint. The sprint must begin and end in the same month for this case. You have
to select the days in the calendar view and choose the item Add sprint in the context menu. In the
appearing dialog (see Figure 3.3, “Insert a sprint”) you have to insert the name and confirm with Ok.

Figure 2.1. Non working days

In the tab Goals you can insert the sprint goals the team and product owner agree upon the sprint planning
meeting. In the tab Definition of Done you can insert the acceptance criteria of the tasks. The tab
Retrospective is considered for saving the result of the sprint retrospective at the sprint end.
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In the tab Tasks all tasks of the sprint are listed. You can filter the entries, by clicking with the right
mouse button on the table caption.

In the tab Statistic you see a table with the members and their working units. The working units that
are not assigned to a team member are summed up the imaginary user -.

In the tab Cards you can create pinboard cards of the sprint. This cards will be saved as a PDF file. Each
side contains up to two tasks. On the front side the topic of the backlog item, the title of the task, the name
of the member and the estimation will be printed. On the back side the task description will be printed.
If you choose the option Create cards optimized for double sided print four tasks
will be printed per page. If you choose the option Create new site per backlog item for
each backlog item a new site will be used.

Note

Pinboard card can only be created if the sprint contains at least one task.

2.1. Time recording

You can manage the working units in the tab Users. First you have to select the member. In the upper
table all tasks of the member will be displayed. Then you have to select the task and in the lower table you
can insert the working unit for the selected task. In the column To do you insert the estimated remaining
effort. In the column Done you insert the actually done effort. You can only insert values for past and the
current date. The column Planned shows the aggregated effort of the user for that day.

Figure 2.2. Time recording
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Figure 2.3. Tool tip of the working time of a member

You can insert the working units of the sprint. If you assign the task to another sprit the previous inputs are
visible in the product backlog view. Choose in the menu bar the menu View → Product backlog and
choose in the tree view the task. In the tab Working date the table contains the working units of the task.

If you move the mouse pointer to the choice box you can see a tool tip. The tool tip contains the planned
times of the member (see Figure 2.3, “Tool tip of the working time of a member”). If you execute a double
click to a task you will change to the product backlog view and the task is selected.

Note

In the choice box only team members will be displayed that have assignments to tasks in the selected
sprint.
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Chapter 3. Planning
You can plan with JAST sprints and other appointments. The planning of the appointments can be done

via Planning or the the tool bar  . The appointments will be displayed as Gantt chart or in a weekly
view (for example Figure 3.1, “Planning an appointment”).

3.1. Gannt view

In the Gantt view you can choose between the time units Hour, Day, Week, Month and Year. If you
choose the option Show sprint backlog items all tasks of the sprints will be displayed. If working
units weren't tracked for the task the task duration is equals to the sprint duration. If you have tracked
working units for the task the start date is the date of the first tracked working unit. The end date is the
date of the last tracked working unit.

Figure 3.1. Planning an appointment

You can insert appointmens by clicking with the right mouse button in the calendar view. If you choose
the menu item Add appointment in the context menu a dialog will open (see Figure 3.2, “Insert an
appointment”).

Figure 3.2. Insert an appointment

You have to insert a title of the appointment, the beginning and the ending date. In the choice box Type you
can choose between Holiday, Qualification, Business trip, Private, Other, Sprint
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planning 1, Sprint planning 2, Sprint review, Sprint retrospective and Daily
Scrum. The description of the appointments is optional. If you insert a description it will be displayed
as tool tip in the week overview.

If you choose the option Full-time appointment the time will be set automatically. The begin will
be 00:00 and the end 23:59.

Note

If you insert the beginning date of an appointment and the option Full-time appointment
is set, the ending date will be automatically set to the beginning date. This only works if the input
field of the end date is empty.

In the Gantt chart non working days like Saturdays and Sundays will be displayed (see Section 5.1.5,
“Planning”).

Note

If the title of the new appointment is empty and you change the type the type will be set as title.

3.1.1. Sprints

You can insert, delete and edit sprints in the Gantt view. If you are editing a sprint you only can change the
title and the beginning and ending date (see Figure 3.3, “Insert a sprint”). If you have selected the option
Mark Saturdays and Sundays as non working days all Saturdays and Sundays in the
sprint will be marked as non working days. All other settings of a sprint can be changed in the sprint view.

Figure 3.3. Insert a sprint

3.2. Weekly overview

The Figure 3.4, “Weekly overview” shows the weekly view of the appointments. With the arrow buttons
at the top of the panel you can navigate weekly. You can insert a new appointment by selecting the range
of time in the calendar and click the right mouse button and choose the menu item Add appointment.
In the appearing dialog you can insert the title, the type, the description and the beginning and ending date.

All appointments in the view can be changed by moving it with the mouse. Appointments that last more
than one day and feasts can not be moved by the mouse. If you want to change feasts you have to open
Options → Settings and select the tab Feasts. The color of the appointments can be changed via
the options dialog, too.

Note

In this view the non working days won't be displayed. The weekly view is considered as help for
planning the sprint meetings and other meetings.
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Figure 3.4. Weekly overview

Note

You can set the begin of the week in the options dialog (siehe Section 5.1.5, “Planning”).

3.3. Table of appointments

All appointments are listed in the table of the appointments (see Figure 3.5, “Appointment view”).

Figure 3.5. Appointment view
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Chapter 4. Diagrams
If a product is open you can view different diagrams. You have the possiblity to print the shown diagrams
or save them as image files.

4.1. Product burndown chart

The product burn down chart (see Figure 4.1, “Product burndown chart”) shows the remaining effort of
the backlog. The bars represent the estimated and in the sprint done effort. The solid line shows the ideal
trend of the remaining effort. The calculation of the ideal effort is the initial effort divided by the count of
the sprints. The duration of the sprint isn't considered here.

The gray dashed line shows the sum of the estimated task durations. The value from sprint 1 is the sum of
sprint 1 to sprint 17. The sum in sprint 2 is the sum of sprint 2 to sprint 17 and so on.

The dark gray dashed line shows the expected trend from the current sprint on. It is expected that the tasks
from the current sprint will be done completly. The expected velocity is calculated from the velocity from
the past sprints. In this line the sprint duration will be considered. The line is only significant if the team
size remains equally.

Figure 4.1. Product burndown chart

Hint

If you name sprints in the form x-y only the part before the dash will be shown. For example
Sprint-1 results in 1.

4.2. Sprint burndown chart

The sprint burn down chart shows the remaining effort in the sprint. The blue line represents the ideal trend.
The red bars represents the actual effort. Days that are non working days won't be displayed in the diagram.

If you don't track the working times as descriped in Section 2.1, “Time recording” a done task will have
no remaining effort on the last day of the sprint.



Diagrams

18

The Figure 4.2, “Sprint burndown chart” shows that the non working days won't be displayed (1st to 3rd
March).

Figure 4.2. Sprint burndown chart

4.3. Diagram of costs

The diagram of the costs shows the actual costs per sprint of the members as stacked bar chart.

4.4. Sprint overview

The overview as Gantt chart shows the continious trend of the sprints. The green bar shows the state of
completion in percent.

4.5. Sprint velocity

This line diagram shows the sprint velocity of the past sprint, the average sprint velocity and the normalized
sprint velocity. The normalized sprint velocity is calculated by the sprint velocity divided by the duration
of the sprint in days. This normalization allows a better comparison of sprints that have different durations.
This diagram is only significant if the working time of the member will be tracked (see Section 2.1, “Time
recording”).

The diagram shows only the past sprints and the current sprint.
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Figure 4.3. Sprint velocity

4.6. Member velocity

The line diagram shows the velocity of each member and the average velocity of all sprints, the single
sprints and the normalized sprints. The three average values are dashed. This diagram is only significant
if the working time of the member will be tracked (see Section 2.1, “Time recording”).

The diagram of the member velocity considers only the past sprints and the current sprint.

4.7. Epic diagram

The pie chart shows the original todo and done durations or function points of the epics. Epics that have
an estimation of 0 won't be considered in the chart.



20

Chapter 5. Options
In the options dialog you can set the values for the log console, the data base, Bugzilla, the planning, the
feasts, the default values, the conversions, the spell checker and LaTeX.

If you click the button Ok on the dialog the settings will be stored and the dialog will be closed. If you
click on the button Apply the settings will be stored and the dialog remains open.

Note

You can not undo and redo saved settings.

5.1. Settings

5.1.1. Logs

Figure 5.1. Log settings

In the tab Logging (Figure 5.1, “Log settings”) you can change the following values:
• Logging level: You can choose between the levels ALL, TRACE, DEBUG, ERROR, FATAL, INFO and
WARN. If you turn logging to OFF the logging will be deactivated.

• Maximum file count: The maximum number of files the logger should create.
• File size: The maximum size of a log file.
• File name: The file name defines the name of the log file. You can use here a relative path, too.
• File name pattern: If a log file has the size specified in File size the file will be closed and com-

pressed to a ZIP archive. If you want to store more than one file you should use the place holder %i
for the running number of the archive file.

• Pattern: In this choice box you can choose between four predefined patterns for the logging.

Note

The log files won't be deleted automatically after terminating or restarting JAST. If you have for
example a maximum file count of 10 and the file size specified to 1024 MB, log files will use up
to 10 GB (ten files and each has the size of one GB).
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The settings of Figure 5.1, “Log settings” will be stored in the file logback.xml. If you use the installed
version of JAST the file is located in the sub folder jast/config of the user folder. If you use in
contrast the portable version the file logback.xml is located in the sub folder config relative to the
start folder of JAST.

The settings will be active since version 0.3.1 immediately in the file and console logging. A restart of
the application isn't necessary anymore.

5.1.2. Data base

In oder to connect to the data base you have to set the following values (Figure 5.2, “Database settings”).

• Driver: You specify the driver for the data base, for example com.mysql.jdbc.Driver for a
MySQL data base.

• Dialect: The dialect you are choosing here should fit the data base driver (for a MySQL data base in
version 5 for example org.hibernate.dialect.MySQL5Dialect).

• URL: You have to specifiy where the data base is available for example jdbc:mysql://local-
host/db.

• User: User of the data base that is used to login in.

• Password: The password of the user. This password will be stored as clear text in the file
database.properties.

• Pool size: The pool size has by default the value 2.

• Data Definition Language: If you store a product for the first time to the data base and all data base
tables aren't created you can choose create. In all other cases you should use the option update.

Figure 5.2. Database settings

The data base settings will be stored in the file database.properties in the configuration folder.

5.1.3. Bugzilla

You can use JAST with Bugzilla Version 3 (see Figure 5.3, “Bugzilla settings”).

• URL: Insert the URL of the Bugzilla server.

• Login name: You insert here the login name of the Bugzilla user.
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• Password: The password of the Bugzilla user.

• Product name: The name of the product in Bugzilla.

Figure 5.3. Bugzilla settings

The Bugzilla settings will be stored in the file bugzilla.xml in the configuration folder.

5.1.4. LaTeX

You can choose whether a TeX or a PDF file should be created. PDF files will be generated with the ap-
plication pdflatex. If you want to create PDF files directly you have to insert the path to the application
pdflatex. You can insert the file path relatively.

Figure 5.4. LaTeX settings

5.1.5. Planning

In the tab Planning you can set the values that are used in the planning view (see Figure 5.5, “Plan-
ning settings”). The following settings have only effect to the weekly view (see Section 3.2, “Weekly
overview”).
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Figure 5.5. Planning settings

• Work begin: Insert the hour on which the work begins (default: 08:00).

• Working end: Insert the hour on which the work ends (default: 17:00)

• Begin of week: You can choose the first day of the week. You can choose between Sunday and Monday.
This settings has only an effect to the week overview (see Section 3.2, “Weekly overview”).

• Show Saturdays: If you have chosen this option the Saturday will be displayed in the week overview.

• Show Sundays: If you have chosen this option the Sunday will be displayed in the week overview.

You can change the background color of the appointments. The colors are used in the Gantt view (see
Section 3.1, “Gannt view”) and in the week overview. The Scrum appointments will have by default a
yellow background and other appointments a green background.

The configuration of the planning settings will be stored in the file planning.xml in the configuration
folder.

5.1.6. Feasts

You can insert feats (see Figure 5.6, “Feasts”) that should be displayed in the calendar of the non working
days (see Figure 2.1, “Non working days”) and in the week overview of the appointments (see Figure 3.4,
“Weekly overview”). The feasts are displayed if you have selected them in the column Show. At the end
of the table the movable feats will be listed. You haven't the possiblity to insert movable feasts. You can
only insert feasts that take place yearly.



Options

24

Figure 5.6. Feasts

The feasts will be stored in the configuration folder in the file feasts.xml.

5.1.7. Default values

In this panel you can insert the following default values:

• Name of the product

• Title of the epics

• Topic of the backlog items

• Title of the tasks

• Title of the sprints

• Title of the impediments

• Sprint duration in days

• Maximum priority

Figure 5.7. Default values
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Note

The value for Sprint duration has to be an integer greater than zero. The value for Maximum
priority has to be an integer (zero or greater than zero).

If you open a project with priorities that are greater than the value in the field Maximum priority the
maximum priority in the defaults tab will be ingnored.

The default values are stored in the configuration folder in the file presetting.xml.

5.1.8. Conversion

In this panel you can change the default values for the conversion of the time units. All values are in
relation to hours.

Figure 5.8. Conversion of the time units

The automatic conversion is deactivated by default. You can turn it on by selecting the option Activate
conversion.

The configuration of the conversions will be stored in the file conversion.xml in the configuration
folder.

5.1.9. Spell checker

You can choose the language of the spell checker in this panel. You can also specifiy the following settings:

• Ignoring words which consist only of upper case literals.

• Ingnoring words which contain digits.

• Ignoring the lower and upper case.
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Figure 5.9. Spell checker settings

The configuration of the spell checker will be stored in the file spellchecker.xml in the configuration
folder.

5.2. Log console

If you choose in the menu bar Options → Log console you can see the current logging items. If you
select the button Clear the content of the logging console will be deleted.

Figure 5.10. Log console

If you select the text in the logging console you can copy it by pressing the short cut Ctrl+C to the clipboard.
Then you can insert it in other applications. If you find bugs in JAST it is easier for me to find them if you
give me the log file or the extract from the logging console.

In addition to the ouput in the logging console the output will be logged in a file. The maximum count of
the log files, their size and the folder of the log files can be specified in the tab Logging in the dialog
settings dialog (see Section 5.1.1, “Logs”).

Note
The logging console shows only the latest output and its output is limited to 64 KB.

Important
Log entries which results from data base access via Hibernate are shown from log leven WARN and
higher. You can't change this setting via the GUI.

5.3. Language

You can use the languages German and English. Since version 1.3 the English versions of the manual and
the help are integrated in JAST.
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Note

If you change the language this won't have any effect to the language of the spell checker. This
setting can be changed in the tab Spell checker (see Section 5.1.9, “Spell checker”).
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Chapter 6. Report
JAST can create reports. The layout of this reports is stored in XML files. You can edit this files with
iReport [http://jasperforge.org/projects/ireport].

With iReport you have access to the data in the XML files or in the data base.
• Product backlog report: This report lists all tasks of all backlog items.
• Sprint estimation report: This reports shows all tasks of the sprint. Each task lists the estimated time,

the actually needed time and the differenc. If the percentage value of the difference is negative less time
was need than estimated.

Important

In this reports there will be no replacement of any characters (Section A.3, “Replacement of char-
acters in LaTeX reports”).

http://jasperforge.org/projects/ireport
http://jasperforge.org/projects/ireport


29

Chapter 7. LaTeX
JAST (version 0.7 or higher) is able to export reports to LaTeX. The generated reports use the KOMA
script and TikZ. If you want to generate PDF files out of LaTeX files in Windows you can use MikTex.
If you use Linux you can use TeX Live:

• MikTeX: http://miktex.org/

• TeX Live: http://www.tug.org/texlive/

The dialog from Figure 7.1, “LaTeX settings” shows the settings for the document class, language, paper
size and if you want to use one or double sided print.

Figure 7.1. LaTeX settings

If you generate a LaTeX report special characters will be replaced. The list is shown in Section A.3,
“Replacement of characters in LaTeX reports”. You can begin an itemization with an asterisk (*). The
asterisk must be the first character in the line or only blanks or tabs are in front of the asterisk. The second
level of itemization starts with a plus (+). The third level starts with a tilde (~).

If you insert the text from Figure 7.2, “Itemization” the LaTeX code from Figure 7.3, “Itemization in
LaTeX” will be generated.

* Item 1
  + Item 1.1
    ~ Item 1.1.1
    ~ Item 1.1.2
  + Item 1.2
* Item 2
    

Figure 7.2. Itemization

http://miktex.org/
http://www.tug.org/texlive/
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\begin{itemize}
\item Item 1
\begin{itemize}
\item Item 1.1
\begin{itemize}
\item Item 1.1.1
\item Item 1.1.2
\end{itemize}
\item Item 1.2
\end{itemize}
\item Item 2
\end{itemize}
    

Figure 7.3. Itemization in LaTeX

7.1. Requirement document

A requirement document lists all backlog items and their requirements. In the introduction chapter infor-
mation about the team und the description of the project will be provided.

7.2. Sprint reports

This report lists the description of the project and the following items of a sprint (if available):
• Sprint burndown chart
• Description of the sprint
• Goals of the sprint
• Definition of done
• Retrospective
• Sprint backlog
• Table with the sprint velocities

Note

If you generate a sprint report the title of the sprint will be suggested as file name.
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Chapter 8. Data base
JAST supports at the moment the following data base management systems:
• H2 [http://www.h2database.com/html/main.html],
• HSQLDB [http://hsqldb.org/],
• MySQL [http://www.mysql.com/] and
• PostgreSQL [http://www.postgresql.org/].

8.1. Create tables

In order to use the data base interface you have to set up the data base. If you have access to a data base JAST
can initially set up the necessary tables. JAST can also create a scheme file for the data base management
system (Database → Schema generation). This file can be imported by the data base management
application. You can only import the schema or execute data base actions if you have the necessary rights.

8.2. Data base operations
• Download: A dialog will open in which you can choose the product.
• Update: If the product isn't in the data base the product will be stored in the data base. If the data base

exists already in the data base only the changed items will be updated. If you have deleted items from
the product backlog the erasure won't be performed to the data base. In this case you have to store the
product to the data base. A product is identified in the data base by its identifier (ID) and the chosen title.
If you change the title and press Update the product will be stored with its new name in the data base.

• Store: If you execute this command the product will be stored to the data base. If the data base has
already existed in the data base it will be overwritten.

• Remove: A dialog will appear and you can choose the data base you want to delete.
• Schema generation: You can generate the schema file of the data definition language (DDL) of the

corresponding data base management system. If you have no rights on the data base you can give the
generated file to your data base administrator and ask him to import the file in the data base. And then
the necessary tables will be available and you can use the data base with JAST.

8.3. Restrictions

String that are stored in the data base are limited to a maximum of 255 characters. Only the following
strings are limited up to 65.536 characters:
• Product: Description.
• Backlog item: Description, requirement and acceptance.
• Task: Description.
• Sprint: Description, goals, definition of done and retrospective.
• Impediment: Description.
• Appointments: Description.

8.4. Configure data bases

8.4.1. H2

In the folder lib the file h2-1.3.174.jar is located. You can start the H2 data base with the following
command:

http://www.h2database.com/html/main.html
http://www.h2database.com/html/main.html
http://hsqldb.org/
http://hsqldb.org/
http://www.mysql.com/
http://www.mysql.com/
http://www.postgresql.org/
http://www.postgresql.org/
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java -jar h2-1.3.174.jar      
      

If users from other systems should have access to the data base you can use the following command:

java -jar h2-1.3.174.jar -tcp -tcpAllowOthers      
      

You have to insert the following command if you want to use the TCP port 51729.

java -jar h2-1.3.174.jar -tcp -tcpPort 51729 -tcpAllowOthers
      

Further information to the H2 data base are given on the homepage H2 Tutorial [http://
www.h2database.com/html/tutorial.html].

Important

You have to use Java 1.7 or lower. The file h2-1.3.174 cannot be started with Java 1.8 or higher.

8.4.2. MySQL

With the following commands you can create a data base JAST and grant the user root on the system
192.168.1.41 all rights. The user root uses the password password:

CREATE database JAST;
GRANT ALL PRIVILEGES ON JAST.* to root@192.168.1.41  
  identified by 'password';
      

http://www.h2database.com/html/tutorial.html
http://www.h2database.com/html/tutorial.html
http://www.h2database.com/html/tutorial.html
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Chapter 9. Bugzilla
If you have finished the settings for Bugzilla, you can see all entries to the product by selecting Options
→ Bugzilla. To each entry the summary, the component, the status, the assignee, the severtiy and the
date of the last change will be shown. The access to the entry is read-only. Therefore you can't change
any value of the entry.

Figure 9.1. Bugzilla

You can put a filter to the table by clicking with the right mouse button on the column caption.
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Appendix A. Appendix
A.1. Short cuts

Short cut Tool bar Description

Alt+D Load product form the data base

Alt+U Update product in the data base

Ctrl+N Create new project in the data base

Ctrl+O Open project

Ctrl+S Save project (as)

Ctrl+Z Undo

Ctrl+Y Redo

+ Increase the priority of a backlog item by 1

- Decrease the priority of a backlog item by 1

Alt++ Collapse all nodes which backlog items are not worked on

Ctrl++ Collapse all nodes

Ctrl+- Retract all nodes of the product backlog

Ctrl+C Copy backlog item or task

Ctrl+V Insert backlog item or task

Ins Create entry in the product backlog

Del Delete entry from the product backlog

F1 Show help

F2 Edit entry in the product backlog

F5 Update view

F7 Spell checking

Pos1 Select node product in the product backlog

End Select last node in the product backlog

Table A.1. Short cuts

A.2. Tips and tricks

A.2.1. Window is not in the visible area

If the main window or another window is out of the visible area you should close the application. Open the
file options.xml and change the values of the variables topLeftX and topLeftY to positive num-
bers. The file options.xml is in the portable version in the subdirectory config and in the installed
version in the user directory of the current user in the subdirectory jast.
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<WindowList>
  <Window>
    <height>886</height>
    <type>MAIN</type>
    <width>1616</width>
    <topLeftX>-8</topLeftX>
    <topLeftY>-8</topLeftY>
  </Window>
</WindowList>
        

Figure A.1. Extract from the options file

The Figure A.1, “Extract from the options file” shows the settings of the main window.

A.2.2. Desktop link on Windows

If you use the portable version of JAST for Windows and you want to create a link to the desktop the
path to the executable must be set in the link. If the link isn't set the configuration and translation files
won't be found.

A.3. Replacement of characters in LaTeX reports

The following table shows which characters in the text will be replaced when a LaTeX report will be
generated.

Original character Replacement

- --

" " \glqq \grqq or \glqq \glqq

& \&

-> →

<- ←

<-> ↔

'test.xml' \verb|test.xml|

--- \hline

'public int sum(int n) {              
  if (n <= 0) {
    return n;
  } else {
    return n + sum(n-1);
  }
}'
              

\begin{lstlisting}           
public int sum(int n) {              
  if (n <= 0) {
    return n;
  } else {
    return n + sum(n-1);
  }
}
\end{lstlisting}        
              

`public int sum(int n) {              
  if (n <= 0) {

\begin{lstlisting}           
public int sum(int n) {              
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Original character Replacement
    return n;
  } else {
    return n + sum(n-1);
  }
}`
              

  if (n <= 0) {
    return n;
  } else {
    return n + sum(n-1);
  }
}
\end{lstlisting}        
              

**important** \textbf{important}

* Item 1              
              

\begin{itemize}              
\item Item 1
\end{itemize}
              

            
+ Item 1.1
              

\begin{itemize}              
\item Item 1.1.
\end{itemize}
              

~ Item 1.1.1
              

\begin{itemize}              
\item Item 1.1.1
\end{itemize}
              

Table A.2. Replacement of characters in LaTeX reports

Important

In the source code environment no replacments will be execurted.

Note

In advanced input fields the input will be converted to HTML and displayed as HTML.

A.3.1. Tables

Tables can be coded with the pipe symbol (|) in JAST. In the table you can use the markup for bold text
and program code. The program code can't contain any line breaks.

Note

You can't use tables in itemization environments and in tables itemizations aren't allowed, too.

Example A.1. Table with two columns

The following source code will be converted to a table of the type longtable in LaTeX.

|Column1|Column2|
|Value1 |Value2 |
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Table as LaTeX code:

\begin{longtable}{|l|l|}
\hline
Column1 & Column2\\\hline
\hline
\endhead
Value1 & Value2\\\hline
\end{longtable}
        

By default the value of a column will be left aligned. You can change the alignment if you set the alignment
explicitly. The alignment is valid until in another row a new alignment will be chosen. The string ---
leads to left aligned text, :---: to centered text and ---: to right aligned text.

Example A.2. Alignment of columns in tables

The following source code aligns the columns. In the first column the values Column 1 and 1 will be left
aligned and 4 will be centered. In the second column the values Column 2 and 2 will be centered and
the value 5 will be right aligned. In the third column the values Column 3 and 3 will be right aligned
and 6 will be left aligned.

|---     |:---:   |---:    |        
|Column 1|Column 2|Column 3|
|1       |2       |3       |
|:---:   |---:    |---     |
|4       |5       |6       |
        

Table as LaTeX code:

\begin{longtable}{|l|c|r|}
\hline
\multicolumn{1}{|l|}{Column 1} & \multicolumn{1}{|c|}{Column 2} & 
  \multicolumn{1}{|r|}{Column 3}\\\hline
\hline
\endhead
\multicolumn{1}{|l|}{1} & \multicolumn{1}{|c|}{2} & 
  \multicolumn{1}{|r|}{3}\\\hline
\multicolumn{1}{|c|}{4} & \multicolumn{1}{|r|}{5} & 
  \multicolumn{1}{|l|}{6}\\\hline
\end{longtable}
        

A.4. Spell checker

JAST provides a spell checker for the languages English and German. The spell checker is integrated in
multi-line textfields. When you press the key F7 or open the context menu the spell checker dialog appears.

If you choose English in the menu Options → Languages the English spell checking will start.



Appendix

38

All words that are unknown to the system can be added. For each language a user defined dictionary file
will be created. This file is in the portable version stored in the subfolder config. The user defined
dictionary file is called UserDictionary_en.txt in the English version. You can edit this file with
a text editor if necessary.
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